
Accessible Communications 
Policy  

Government of Newfoundland and Labrador 

Accessible public documents, government publications, 
news releases, electronic and web-based information, public 
information sessions, meetings, consultations, press 
conferences and events. 
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Available in alternate formats. 
Please contact the Disability Policy Office:  
Email: disability.policy.office@gov.nl.ca  
Phone: 709 729-6279 Toll Free: 1-888-729-6279 
TTY: 709 729-5440 Toll Free: 1-888-729-5440  
  

mailto:disability.policy.office@gov.nl.ca
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Implementation
 

 
Coordination: Corporate 
communications staff oversees 
implementation of the Accessible 
Communications Policy. 
 
Training: Training will be integrated into 
current courses and learning 
opportunities as relevant. For example, 
training on how to create fillable forms 
will include a focus on what is required 
to make sure they are accessible and 
follow the appropriate standards. The 
commitment and requirement that all 
government information and 
communications are accessible will be 
incorporated into the On Boarding 
Program and other orientation, 
management and learning sessions.  
 
Resources: The Disability Policy Office 
will provide training materials, resources 
and consultations as requested.  
 
Review: The Disability Policy Office will 
review policy annually or as required to 
ensure current accessibility standards 
and consumer demands are being met.
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Public Information
 

Public Events

Documents and publications include 
news releases, electronic and web-
based information, pamphlets, posters, 
infographics, public announcements or 
information sessions, public 
engagement and consultations. 
 
All documents posted to the web must 
be in accessible format. See Appendix 
C How to Make Your Documents 
Accessible. 
 
Consider clear (plain) language when 
writing any type of document. Use 
person first, respectful language.   
Incorporate clear print guidelines; see 
CNIB Clear Print Guidelines.  
 
Use 12-14 point, sans serif font; strong 
colour contrast and white space. Do not 
use italics or all upper-case letters. Bold 
can be used for emphasis.  
 
Example: News releases will use a sans 
serif font (e.g. Arial) of at least 12 point 
font size. 
 
Documents should be reviewed by 
typical readers or tested by an on-line 
checker ex: Plain English checker . 
 
Public information will be available in 
alternate formats upon request. This 
includes Braille, large print, audio 
(MP3), and sign language versions.  
 
See Alternate Formats section for 
further information. 

In forums where public information is 
shared, for example hold public 
engagement or consultations, news 
conference or announcements 
participants will be informed that they 
can request disability-related 
accommodations or supports.  
 
Requests for accommodations may 
include alternate formats, sign language 
interpretation, captioning or assistive 
hearing technology.  
 
Individuals may bring their own support 
person i.e. decision-making supporter, 
plain language interpreter or service 
animals. 
  

http://www.cnib.ca/en/services/resources/Clearprint/Documents/CNIB%20Clear%20Print%20Guide.pdf
http://www.plainenglish.org/
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Electronic and Web-based 
Information 

 
Web accessibility refers to how well 
people with visual, hearing, motor and 
cognitive disabilities can access a 
website.  
 
Web-based information using public 
documents in portable document format 
(pdf) will be formatted as accessible 
pdfs. Word and/or HTML versions may 
also be made available. 
 
Websites and e-services will achieve a 
minimum Level AA standard of the 
version 2.0 ISO/EIC International 
Standard 40500:2012. See Accessibility 
Guidelines (WCAG) .   

OCIO Help site has resources to help 
with making electronic document, forms 
and web sites accessible. 
 
Resources are available to assist in 
creating accessible websites such as 
WebAim. 
 
Web accessibility checkers are available 
to test websites for accessibility such as 
achecker  or wave. 
 

Social Media 

 
Social media sites like Facebook, 
LinkedIn, Twitter, YouTube, blogging 
websites and Google+ do not meet 
accessibility standards.  
 
Social media usage will include tag lines 
that alternate formats are available upon 
request. 
 
Alternative website portals, mobile 
applications (apps) and additional 
keyboard navigation shortcuts are 
available to increase accessibility to 
social media.  
 
For additional information and resources 
see media access. 
 
A text alternative such as an 
accessible word document, accessible 
pdf or HTML version should be provided 
with audio and video media that is 
posted to government websites. 
 
  

http://www.w3.org/WAI/intro/wcag.php
http://www.w3.org/WAI/intro/wcag.php
https://ociohelp.psnl.ca/SitePages/Home.aspx
http://webaim.org/resources/
http://achecker.ca/checker/index.php
http://wave.webaim.org/
http://www.mediaaccess.org.au/
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Alternate Formats 

Alternate formats include Braille, large 
print, audio (MP3), clear language, 
captioning, sign language and electronic 
versions. 
 
All documents and publications will 
provide a tag line indicating contact 
information for requesting alternate 
formats. See Appendix D for sample 
tag lines.  
 
Alternate format requests will be 
processed in a timely manner and at no 
extra charge to the requestor. 
 
Wherever possible, documents will 
have American Sign Language (ASL) 
versions and videos will be visible in 
ASL. 

Critical alerts and emergency 
messages will have links to American 
Sign Language (ASL) versions in video 
format. 
 
News conferences which have a 
significant impact on the province or are 
relevant to life safety will be captioned 
and interpreted into sign language. This 
determination will be made on a case by 
case basis. 
 
Televised advertisements and public 
videos will be captioned. See 
captioning guidelines for more 
information and Appendix E for caption 
providers.  
 
YouTube messages should be 
captioned. There is a built in captioning 
feature in YouTube.  
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Captioning
 

 
Captioning is the process of 
transcribing audio verbatim or edited 
and displaying the text on a television, 
monitor or video screen.  Captioning 
processes also include a visual 
depiction of sound effects and music.  
 
The following products are to be 
captioned: television advertisements, 
videos uploaded to the internet or 
YouTube videos, promotional media, 
and general information DVDs playing in 
a customer service area, public event or 
trade show. 
 
Captioning can be either closed or open. 
Closed captioning requires a decoder 
and can be turned off and on. Open 
captioning is seen by everyone and is 
always on. 
 
Closed captioning is incorporated into 
all television advertising made for or by 
the Government of Newfoundland and 
Labrador. 
 
Open captioning is incorporated in 
video products that will be shown in 
public areas, such as customer service 
areas, public functions or trade shows. 

 
Any DVD or CD-ROM the public can 
request, rent, or purchase should be 
closed captioned. This includes 
previously produced materials where 
feasible. 
 
All government departments and client 
service centers are required to caption 
materials that will be viewed by the 
public regardless if developed for 
provincial, national or international 
audiences. 
 
A text alternative such as an 
accessible word document, accessible 
pdf or HTML version should be provided 
with audio and video media that is 
posted to government websites. 
 
Captioning is the final stage of the 
production process. It is advisable to 
consult with a captioning organization 
before filming. This will minimize costs 
and ensure that presentation of the 
captioning maximizes comprehension 
and captures the essence of the 
product.  
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Captioning Agreements
 

 
Departments entering into joint 
sponsorship with other agencies 
and/or private sector organizations will 
ensure captioning/text alternative 
requirements are included in relevant 
documents; i.e. quotes, contracts, 
agreements.  
 
Requirements for captioning and text 
alternatives will be included within 
Requests for Proposals, tender calls 
and contracts. See Appendix D for 
sample tag lines for contracts and 
Requests for Proposals. 

Departments will ensure suppliers 
and producers of visual products supply 
a script of the audio for use in 
captioning.  
 
Public announcement videos, DVDs or 
CD ROMs that are currently in use but 
are not captioned, shall be captioned 
before being used in public wherever 
feasible.  
 
Television advertisements that are 
rebroadcast will be captioned.  
 
See WCAG 2.0 Guidelines. 
  

http://www.w3.org/TR/WCAG20/
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Public Engagement/Consultations
 

 
Planning for accessibility is best 
represented when features are ‘built in’ 
as an integral part of the design and 
development process.  
 
Accessibility and inclusion should be a 
regular part of planning and conducting 
public meetings and consultations.  
 
The Inclusive Public Engagement policy 
is available from Communications and 
Public Engagement or Disability Policy 
Office.  
 
Public engagement, consultations 
and events will be held in accessible 
locations. Event planning and delivery 
will consider accessibility and 
communication needs of persons with 
disabilities. 
 
Disability-related 
accommodations/supports will be 
provided upon request. 
 
This can include: alternate formats i.e. 
large print, Braille, accessible pdfs; 
captioning; assistive listening devices; 
assistive technology or sign language 
interpreting services. 
 
A portable sound system (‘Ruby’) with 
a built-in FM transmitter for assistive 
listening devices and telephone 
interface for remote captioning is 
available from the Disability Policy 
Office. 

 
See Appendix H for additional 
information on hearing assistive 
technology or assistive listening 
devices.  
 
Attendees may wish to avail of their 
own personal supports such as a 
decision-making supporter or plain 
language interpreter or service animal.  
 
Promotion materials, notices and 
registration forms will include a tag 
line inviting participants to inform 
organizers of disability-related 
accommodations/supports required for 
their participation. 
 
See Appendix D for sample tag lines for 
meeting notices and invitations.  
See Appendix I for a sample 
accommodation registration form.  
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Respectful Language/Imaging
 

 
Person first terminology is a 
respectful method of communicating 
and places the person before the 
disability in any sentence or phrase 
structure. For example, a person who is 
blind or a person with an intellectual 
disability is person first terminology. 
 
Person first terminology should always 
be used with the one exception of 
people who are culturally Deaf. See 
Appendix G. 
 
Avoid using, printing or posting the word 
‘the’ before terms for disabilities; for 
example ‘the blind’ or ‘the deaf’ are not 
acceptable terms. 
 
Avoid words and phrases that set 
people with disabilities apart from 
others.  For example, ‘those who …’ or 
using ‘we/them’ terminology. 
 
Such words undermine the role of 
people with disabilities in society directly 
and by implication.  
 
Only reference a disability when directly 
relevant to the message or 
communication. For example, “An 
employee who is blind was recognized 
at the Public Services award ceremony.” 
is not appropriate as the reference to 
disability is not relevant to the 
achievement or recognition.  
 
See Appendix G for guidelines of words 
to use and not use.

See Appendix J for communication tips 
for referencing a person with a disability.  
 
When communicating with persons 
with disabilities:  

• ask before you help 
• be sensitive about physical 

contact 
• speak directly to the person not 

their support person 
• do not make assumptions about 

the needs and preferences of the 
individual.  

 
Respectful in-person service 
acknowledges the diversity of people 
and their needs.  
 
Use images that show people with 
disabilities as active participants of 
society. 
 
Portraying persons with disabilities 
interacting with others without 
disabilities in social and work 
environments helps break down 
barriers.  
 
Be self-aware and advocate for inclusive 
and respectful language. 
 
See Disability Portrayal Issues/Media for 
more information.  

http://rtcil.org/products/media
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Appendixes
 

Appendix A:  Glossary 

Accessible  
 A general term used to describe something that can be easily accessed or used.  

Alternate Formats 
 A format of publishing information other than standard print. Common alternate 

formats include: electronic, large print, MP3, Braille, CD/DVD, descriptive video, 
signed video, on-screen text / e-text or clear language. A tactile diagram or 
pictogram may be a component of an accessible format document. 

Assistive Technology (AT) 
 An umbrella term that includes assistive devices, adaptive technology, and 

rehabilitative devices. Includes a range of devices, equipment, and software such 
as mobility devises, magnifying devices, visual alarms, hearing aids and speech 
software. 

American Sign Language (ASL) 
 A visual language with unique vocabulary, grammar, syntax, and social rules of 

use.  Meaning is conveyed through signs that are composed of specific hand 
shapes; palm orientation; movement and location of the hands; and signals on 
the face and body. 

Assistive Listening Devices (ALD) or Hearing Assistive Technology (HAT) 
 Wireless Systems: use FM technology (radio waves): infrared (IR) or audio loop 

(induction) systems to transmit sounds wirelessly to the listener’s hearing aids or 
head set. 

Barrier 
 Anything that prevents people with disabilities from participating on an equal 

basis as others. Barriers can be physical, attitudinal, systemic, or technological. 

Braille 
 A series of raised dots that can be read by touch, usually fingertips. 
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Communication Access Real-time Translation (CART)  
 A specially trained caption provider transcribes voice to text with 1-2 second 

delay through use of specialized technology. Also used in very specific situations 
are: 

o Computer-Assisted Note taking: limited information; does not capture 
everything being said; and 

o Caption Display Board: manually transcribes what is being spoken into 
displayed captions.  

Clear or Plain Language  
 A set of principles that focuses on the requirements of the reader and includes 

sentence length, sentence structure and the use of headings, fonts and white 
space. Information is presented in a logical order using common, everyday words 
and expressions familiar to the culture of the reader; avoids jargon and uses a 
minimum of technical language.  

Clear Print  
 A design approach that considers the design elements, such as font style, type 

size, contrast, page navigation, words, graphics and white space. Considered in 
all forms of written communication including flyers, notices, newsletters, 
pamphlets, application forms and web site pages. 

Consumer 
 People who self-identify as having a disability. 

Described Video 
 Is the use of an audio ‘voice over’ describing what is being portrayed on a 

screen, monitor or television program. 

Decision-making Supporter 
 A person (or persons) who support an adult to communicate his/her will and 

intent to inform decisions.  Supporters know the person well and have a 
relationship of trust that brings an understanding to the person’s unique way of 
communicating and understanding. Supporters do not make decisions for the 
person and are not substitute decision makers. Supporters may assist the adult 
throughout the decision making process or for a specific purpose.  

Disability-related Accommodation/ Supports 
 Any technical aid or device, personal support or disability-related support or other 

accommodation a person may require. This can include, but is not limited to: 
accessible meeting rooms; accessible formats such as Braille and clear 
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language; mobility supports to attend a meeting; visual language interpreters or 
decision making supporters. 

Disability 
 The Disability Policy Office uses language of the Convention on the Rights of 

Persons with Disabilities which does not define disability but rather describes it 
as “…an evolving concept and that disability results from the interaction between 
persons with impairments and attitudinal and environmental barriers that hinders 
their full and active participation in society on an equal basis with others.” The 
Convention describes people with disabilities as including people with long-term 
physical, mental, intellectual or sensory impairments which in interaction with 
various barriers may hinder their full and effective participation in society on an 
equal basis with others. 

Induction Loop  
 A system that transmits an audio signal directly into a hearing aid via a magnetic 

field, greatly reducing background noise, competing sounds, reverberation and 
other acoustic distortions that reduce clarity of sound.  

Inclusion 
 Meaningful participation in all aspects of society with access to services and 

opportunities for persons with disabilities equal to that of people without 
disabilities; this requires active removal of barriers and provision of disability-
related supports. 

Infra-red Hearing System 
 An assistive audio system typically consists of an audio source, an infrared 

radiator (transmitter) and infrared listening receivers. Used with a lightweight 
headset; a hearing aid; or a direct audio input cord. Infra-red systems are more 
secure as they do not use radio bands like FM systems.  

Sign Language Interpreters 
 Visual language Interpreters who facilitate communication between people who 

use sign language (for example: ASL) and people who use spoken languages 
(English or French).  

Intervenor 
 An individual who provides a professional service, paid or voluntary, to facilitate 

the interaction of a person who is Deaf-blind with other people and the 
environment.  
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Oral Interpreters 
 An individual who facilitates communication in group situations where Deaf or 

hard of hearing individuals rely on speech reading. The oral interpreter mouths 
the words of the speaker, changing them when necessary to synonyms that are 
more visible on the lips.  

Plain or Clear Language Interpreter 
 A person chosen and directed by an individual to explain information in clear 

language. 

Screen Enlargers 
 Software used to make text and images larger.  

Screen Readers 
 Software programs that read out loud what is displayed on the computer monitor. 

JAWS is a popular screen reader software used primarily by people who are 
blind and Kurzweil is a popular software for people with learning disabilities.  

Tele-typewriter (TTY) 
 A telephone communication device that sends typed messages through a phone 

line via a TTY to a TTY communication or a TTY to a phone with the use of a 
relay service where an operator facilitates the conversation between two parties 
by relaying the information between typed message and spoken language (type 
message to voice; voice to type message). Note: “Texting” (mobile devices, 
social media, messenger technology) is increasingly preferred over the use of the 
TTY.  

Universal Design (UD)  
 The design of products and environments to be usable by all people, to the 

greatest extent possible, without adaptation or specialized design. Universal 
design principles can be applied to any product, environment, or communication, 
including built environment, web pages, and education curricula. 

USB (or Memory Stick) 
 Data storage device integrated with a USB (universal serial bus) port on a 

computer. 
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Video Relay Services (VRS) 
 A telecommunications service that enables people to use an operator to facilitate 

conversation between two parties by relaying the information between sign 
language and spoken language. 

Voice Recognition Systems 
 Computer software programs that enable operate by voice instead of a mouse or 

keyboard. 

Way-Finding 
 The process of using spatial and environmental information to find one’s way in 

the built environment.  

Web Content Accessibility Guidelines (WCAG) 2.0 
 Internationally recognized standards (ISO/IEC 40500:2012) that define how to 

make web content accessible, including accessible for screen reader software.  
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Appendix B:  Accessible Communications Basic Check List 

What to do How to do it √ 

Accessible document • Minimum 12 point font size, sans serif font (ex: Arial, 
Franklin Gothic) 

• Consistent font throughout; no italics or underline 
• Clear colour contrast between text and background 
• Titles and headings formatted by ‘heading styles’ 

function  
• Pictures, graphics and charts inserted by using  “in line 

with text”  function and descriptions added in the alt text 
function 

• Short sentences, straight-forward messages 
• Tables are simple in structure and color 
• Tables are not merged or nested  

 

Respectful 
language/images 

• Person first terminology i.e. persons with disabilities  
• Avoid using ‘those’ to refer to people 
• Photos that include persons with disabilities as active 

participants of society 

 

Publications  • Tag line included: “Available in alternate format.”  
Web sites / electronic 
documents  

• WCAG version 2.0 Level AA standard.  

Media and Public 
Events Location / 
Venue 

• Level entrance or if ramped, slope no steeper than 1:16 
ratio 

• Door opening minimum 36 inches 
• Automatic door opener (or volunteer to help) 
• Remove obstacles i.e. waste containers, loose cords 
• Ensure elevator is working and not key operated 
• Washroom door minimum 32 inch with 5 foot turning 

space  
• Designated blue zone(s) parking with signage 
• Tag line included: “Disability-related accommodations 

are available upon request; [insert contact information]” 
• Book required service providers 

 

Major news media 
events 

• Audio, captioning and sign language interpretation    

 
Microsoft Word 2010 and Adobe Acrobat Pro XI have a built-in accessibility check 
similar to spell check. Once the document is complete, click on “Check Accessibility” 
tool to review the document; the accessibility checker will identify any errors and 
provided information on how to correct.  
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Appendix C:  How to Make Accessible Documents  

Documents are created in accessible format by using built-in Word features. These are 
found in the tool bar. Make sure the ribbon on top of your work documents shows the 
tool bar and that it includes font, paragraph and styles tabs. 

Language 
• Use short sentences with one thought per sentence. Avoid complex sentences.  
• Use clear language.  

Fonts and Colour Contrast 
• Use sans serif fonts such as Arial and Franklin Gothic. Do not use Times New 

Roman-it is not a sans serif font.  
• Use the same font style throughout the document. 
• Use 12 point font size or larger. 
• Use bold for emphasis. Do not use underline, italics or all caps to emphasize. 
• Capitalize only the first letter in each word, even for a title. 
• Black text on white background is the best practice. Do not use light colour font. 

Titles and Subtitles 
• Do not format titles manually. 
• Always use heading Styles for titles and subtitles in a document. The Styles tab is in 

the Home tab of the menu bar (Normal, No Spacing, Heading 1, Heading 2, Title 
etc).  

 

 
 
• You must first select a style and then follow these steps: 

1. In the Font section in the Home tab format your text.  
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2. Highlight your text and then select the style you want to use from the Style 

section of the Home tab; right click and a drop down menu will appear. 
 

 
 

3. In the drop down menu select Update [style name] to Match Selection. This will 
keep your selection consistent as you continue to write your document.  

 
When making changes to the Style, follow steps #2 and 3. 
• To edit a document that did not follow these guidelines: 

o Highlight your typed text to make changes, select a style and do the same as 
above bullet  

o To change the way it looks, if you want a different size, etc., follow the steps 
above.  

• There is an icon called Change Styles  in Microsoft Word 2010, this tool is not 
do not use this for modifying styles.  

• Headings are numbered to ensure the hierarchy or organization of document.  
Example: 
Heading 1 
 Heading 2 
  Heading 3 

Heading 4 
 
Tip: Use the navigation pane to view the hierarchy /organization of the document. The 
navigation pane is located in the View tab. Click View and you will see an option to turn 
the navigation pane on in the tab called Show.  
• When using headers, footers or page numbers, use Insert Header, Insert Footer or 

Insert Page Number. Do not manually type it in. Located under the Insert tab.  

Table of Contents 
• Insert Table of Contents by using the Reference tab. Do not manually type it in. 
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• Steps to insert table of contents: 
1. Go to the Reference tab and then Table of contents tab. The drop down menu 

shows automatic tables and other options. Select Insert Table of Contents. 
 

 
 

2. When a Table of Contents window appears, edit what Headings you want to 
show on the table of contents and when finished making the changes, click 
OK.  
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Page Layout  
• Use standard margins defaulted as Normal in Microsoft Word and left alignment.  
• White space makes reading easier. 

o To create extra white space in your document do not use tabs or the enter 
button (character return).  Use styles and formatting tools to create the 
extra space found in the Paragraph Formatting menu under the Home tab. 

 

 

• Adjust line spacing by using the Paragraph Formatting icon, found in the 
Paragraph section of the Home tab.  

• Do not press the Enter key repeatedly to start a new page. Go to the Insert tab 
and click Page Break to create a new page. 

• The Track Changes tool can impede accessibility of electronic documents. 
Ensure all track changes have been accepted or removed from your final copy. 
Track Changes tool is located in the Review tab. 

• Converting word document into a pdf- In Microsoft Word 2010 activate Save 
Type As select pdf, and then open Options.  
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• Select Document structure tags for accessibility, click OK.  
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Text Boxes 
• Inserting text boxes:  

1. Go to the Insert tab and click on Text Box in the Text section.  The drop down 
menu has a selection of built in text boxes and an option to draw your own.  

 

 
 

2. Select the text box as desired; insert your text. 
3. It is best practice to insert text box with In Line with Text position. With text box 

highlighted go into Picture Tools Format; click on Position in the drop down menu 
to select In Line with Text. 
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o Text boxes require alternate text information. Alternate text (alt text) 
provides description information for screen reader technology.  

4. Activate the boarder of the text box; right click and select Format Shape; then 
click Alt Text in the list of options on the left hand menu bar.  

 
Format Shape: 
 

 
 
Alt Text:  
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5. Fill in the Title and provide brief and concise descriptions for the text box’s 
information. Click OK to finish. 

Pictures, Graphics, Graphs and Charts 
• Pictures, graphics, charts and tables in your document require alternate text 

information to be added.  Alternate text (alt text) provides description information 
for screen reader technology 

• Steps to add alt text to pictures or shapes: 
1. Right click on the picture/shape to select Format Picture or Format Shape in the 

drop down menu. 
2. When the Format Picture or Format Shape window appears, select Alt Text in the 

left hand panel list. Fill in the Title and Description. After completing it, click on 
the Close button.  

 

 
 

• Insert chart/ graph using the Chart button in the Illustrations section in the Insert 
tab.  

 

 
  



23 
 

• Steps to add Alt text to charts: 
1. Right click on chart and select Format chart in the drop down menu. 

 

 
 

2. In the Format Chart Area window, select the Alt Text in the left hand list. 
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• When inserting pictures, graphics, graphs and charts, click on Position icon in the 
Format tab and select In Line with Text in the drop down menu. Do not use any 
other position or text wrap style. 

 

 

• Word Art, and tools are not accessible.  Do not use.  
 

 
 

• Water marks and background designs, or floating objects impede accessibility.  
• Remove all watermarks on final or public documents. 

Tables 
• Tables are used to help the reader understand the information. Do not use tables 

as a way of organizing or layout for a page.  
• In creating tables and cells within tables do not hide the borders in a table. 
• When you insert a table, a new tab called Table Tools appears on the menu bar. 

The Table Tools tab is activated once you insert a table. In the Table Tools, you 
have the Design tab and the Layout tab. 
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• In the Table Style Options, ensure that header row is checked. Header rows help 
show the information in the table is clearly understood. 

• Use simple table structures that clearly state the data visually. Example: 
 
Organization Email 2017 
 
Organization Email 
ABC name@abc.com 
DEF admin@def.ca 
 

• Avoid merged cells and nested tables. 
• If the table is more than one page, click on Repeat Header Row. This option will 

automatically repeat header row when table is on the next page. In the example 
above, the header row is Organization and Email. This header row will appear 
automatically on each page. 

 

 
 

• Use alt text for all tables. Alt text provides the image decryption for screen reader 
technology. 

  

mailto:name@abc.com
mailto:admin@def.ca
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• Steps to add alt text to tables:  
1. After clicking on your table, click on Properties in the Table section. 

   
 

2. Select the Alt Text tab to fill in the Title (what the table is about) and Description 
(all the information in the table).  

 

 
 
Tip: Use copy and paste function to add the information in the Alt Text’s Description 
box. First copy and paste the table text into a blank Word document. Reformat so that 
the table’s text is in text only and in sentences and bulleted lists; this will describe 
clearly the table’s information. Copy and paste into the Description box, click OK 

• If creating tables in spreadsheets, provide unique names for all the sheet tables. 
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Hyperlinks 
• Hyperlinks are links from a website or a file which when you click on text or 

image it will directly bring you to that link.  
• Steps to create hyperlinks: 

1. Go to the Insert tab and click on hyperlink  
 

 
 

2. In the Insert Hyperlink window, write in a clear title of what the link is in the 
Text to display box. Write the actual website link in the address box click OK 
to create your hyperlink. 

 

 
 

• It is best practice to use hyperlinks, rather than copying and pasting website 
address.  

o Avoid copying and pasting long website addresses in your document as 
much as possible.  

o Example: Use   Disability Policy Office instead of 
http://www.cssd.gov.nl.ca/disabilities/index.html 

• Do not use “Click Here” or “More Info” as a link title. 
  

https://www.gov.nl.ca/cssd/disabilities
https://www.gov.nl.ca/cssd/disabilities
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Sound and Videos 
• If you use additional audio components in a document, ensure that the content is 

available in alternative formats such as closed caption, transcript, or alternative 
text.  

Creating Forms 
• You can create accessible fillable forms. Please check OCIO Help site or contact 

Disability Policy Office for more information.  

Check for Accessibility Tool 

• When you use the Check Accessibility or Accessibility Checker tool  it will 
provide you warnings and errors in the document and guide you on how to fix it. 

• After you finished reviewing and editing your document, always use the Check 
for Accessibility feature to ensure that no accessibility issues exist within your 
document.  

• Steps to insert icon on your Quick Access toolbar: 
1. Select File tab, then Options at the bottom of list and click on Quick Access 

Toolbar.  
 

 
  

https://ociohelp.psnl.ca/Pages/Websites-and-Applications.aspx
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2. Select drop down menu of Commands to select All Commands and select 
Accessibility Checker. Click Add button to add it to your toolbar. 

  
 
 
Tip: Documents saved with the file extension .doc do not have the accessibility checker 
tool in the program. Quick fix is to save the old file with the extension .docx so you can 
use the accessibility checker. 
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Appendix D:  Tag Lines  

Tag lines are used to let people know about disability-related accommodations that can 
be made to support their access and participation on an equal basis as others.  
The following tag lines are recommended to provide consistent and clear messages. 
These should be included as relevant and in a prominent location on all government 
publications, websites and event notices.  

Alternate Formats for website/and print publications  
• Available in alternate format upon request.  

o Optional to add: Requests will be processed in a timely manner. 

eAccess 
• If you experience difficulty in accessing this website or its contents, please 

contact [insert contact information].   
• If you need more information or help accessing website content, please send 

your question to us at [insert contact information]. 

Invitation for requesting disability-related accommodations 
Invitations and promotional materials should inform participants that they can identify 
disability-related accommodations required to attend or participate in the meeting or 
consultation.  

• Disability–related accommodations are available upon request. Please contact 
[insert contact information]. 

Registration Form 
• Please indicate your requirements to help us plan an event that meets your 

accommodation and inclusion needs. 
• See Appendix I for a sample accommodation form used to acquire 

accommodation information from participants. 

Scent Free  
• This is a scent free event.  

o Optional to add: Please do not use products that have fragrances. 

Tenders and Requests for Proposal (RFPs) 
• Procedures and deliverables must meet accessibility guidelines and demonstrate 

inclusivity of persons with disabilities. 
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Appendix E: Disability-related Accommodations Providers  

Interpreting Services 
• American Sign Language 

o Interpreting Services of NL (ISNL) 
Phone: 709 753-5621/ TTY: 709 753-5620 Email: info@isnl.ca 

 
Captioning Services (sample providers) 

• Real Time Computerized Assisted Transcription (CART) Remote 
o Accurate Realtime Incorporated  

Phone: 604 685-6050  Website: www.accuraterealtime.com 
o Realtime STENOvations 

Phone:780 455-5564 
• Captioning (Closed or Open) 

o NIFCO TV/Video 
Phone: 709 754-6121 

o YouTube  Automatic feature of YouTube platform 
 

Alternate Formats  
• Empower, the disability resource center (Braille, Large Print, Audio (MP3) 

Phone: 709 722-4031/ TTY: 709 722-7998  Email: info@empowernl.ca  
• Queen’s Printer (out-source Braille, Large Print) 

Phone: 709 729-3210 
 
Hearing Assistive Technology / Assisted Listening Devices  

• Canadian Hard of Hearing Association – NL  
Phone: 709 753-3224 / Text: 709 725-3224 
Email: info@chha-nl.ca  

• Disability Policy Office (Portable system for loan)  
• Audio-Video companies 

 
Other Accommodations 

• Computerized Note Takers /Transcription (contact Disability Policy Office) 
• Plain Language or Oral Interpreting or Intervenor (contact Disability Policy Office) 
• Decision-Making Supporter (chosen and brought by the individual) 
• Clear (Plain) Language interpreter (chosen and brought by the individual) 

  

mailto:info@isnl.ca
http://www.accuraterealtime.com/
mailto:info@empowernl.ca
mailto:info@chha-nl.ca
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Appendix F:  Sample PowerPoint Slides 
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Appendix G: Words with Dignity  

Language is powerful. The following words and phrases will help you choose language 
that is respectful. Most people with disabilities prefer you use these terms. 
 
Terms to use when referencing people with disabilities:  
 

Use Instead of 

person with a disability 
person who has a disability 
people with disabilities 

the disabled 
handicapped 
afflicted with 
suffering from 
special 
deformed 
differently abled 

person with a mental illness 
person who accesses mental health 
services 

mentally ill 
mental 
insane 
crazy 

person who is deaf 
person who is late-deafened 
person who is hard of hearing 

the deaf 
deaf mute 
hearing impaired 

person with a developmental disability 
person with an intellectual disability 

developmentally delayed 

person who is blind 
person who is partially sighted 

the blind 
the visually impaired 

person with a learning disability learning disabled 
person with a mobility disability physically challenged 
person who uses a wheelchair wheelchair bound 

confined to a wheelchair 
accessible parking 
blue zone parking 

disabled parking 
handicap parking 

sport for athletes with disabilities disabled sport 
community of people with disabilities disabled community 
people those people  

you people 
person without a disability normal 

 
 
Remember: Always put the person first. Avoid ‘us’ and ‘them’. If in doubt, ask. 
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Appendix H: Hearing Assistive Technology 

There are many auditory and non-auditory devices that are collectively known as 
Hearing Assistive Technology (HAT) or Assistive Listening Devices (ALD). 

Assistive listening devices (ALDs) 
• Wireless Systems: use FM technology (radio waves): infrared (IR) or audio loop 

(induction) systems to transmit sound wirelessly to the listener’s hearing aids or 
head set. 

Voice to text technology 
• Communication Access Real-time Translation (CART): a specially trained caption 

provider transcribes voice to text with 1-2 second delay through use of 
specialized technology.  

• The following is also used in very specific situations:  
o Computer-Assisted Note taking: limited information; does not capture 

everything being said; and  
o Caption Display Board: manually transcribes what is being spoken into 

displayed captions.  

Telephone communication devices 
• Teletypewriter (TTY): sends typed messages through a phone line via a TTY to a 

TTY or a TTY to a phone with the use of a relay service Note: “Texting” (mobile 
devices, social media, messenger technology) is increasingly preferred over the 
use of the TTY.  

• Relay service: operator assisted communication facilitating conversation between 
two parties by relaying the information between typed message and spoken 
language (type message to voice; voice to type message) or people who use 
sign language (for example: ASL) and people who use spoken languages 
(English or French).  

• Mobile Applications (Apps). Mobile video streaming supports a person who is 
Deaf to have a face-to-face sign language conversation. Mobile phone apps have 
text to speech and speech to text, video call, and other accessibility features. 

• Telephone amplifiers: in-line amplifiers replace the telephone handset or portable 
amplifiers which attach to the handset and can be used with or without a hearing 
aid.  

Alerting devices 
• The use of flashing incandescent or florescent light, a loud horn, or a vibration   

to send a signal (visual smoke alarm, visual doorbell).
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Appendix I: Sample Accommodation Form 

Please indicate your requirements to help us plan an event that meets your 
accommodation and inclusion requirements. 
 

A. Mobility 
• Physical accessibility (specify):  

 
 

 
 

 
B. Language 

☐Simultaneous interpretation 
☐American Sign Language (ASL)  
☐Plain language interpreter 
☐Langage des signes du Québec (LSQ) 
 

C. Service 
☐Oral interpreter 
☐Assistive listening system 
☐Intervenor 
☐Decision-making supporter 
☐Real time captioning 
 

D. Alternative media 
☐Large print 
☐Electronic format  
☐Braille 
☐Captioned videos 
☐Descriptive videos 
☐Audio MP3 
 

E. Other – Please specify: 
 

Dietary:   
 

 
 

 
Evacuation: 
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Overnight accommodations:  
 

 
 

 
 
 
Name of attendant accompanying me to event:  
 

 
 
Name of plain language interpreter: 
 

 
 
 
Name of decision-making supporter accompanying me to event:  
 

 
 
Other:  
 

 
 

 
 
 [An alternative when seeking accommodation information in the planning stage is to 
invite participants to request alternative formats, disability-related accommodations, 
dietary needs or assistance required in the event of an emergency evacuation. Provide 
contact information.] 
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Appendix J: Communication  

People have varying abilities to receive, express or process information. If unsure, ask 
the person how they would like you to interact with them.  
 
Patience, respect and a willingness to communicate are your best tools. 

Sample Communication Tips: 
• Identify yourself when approaching; speak directly to the person. 
• If you offer assistance, wait until your receive permission or direction.  
• If you cannot understand what is being said, do not pretend. Instead, ask the person 

to repeat him/herself. 
• Check to see if the person understands what you have said. 
• Rephrase information, using different words if person does not understand, or pose 

questions that can be answered '‘yes'’ or '‘no'’. 
• If helpful, provide information in different formats. 
• People may be accompanied by an intervenor, interpreter or support person; speak 

directly to the person, not to the intervenor, interpreter or support person. 
• Sit down when speaking to an individual who uses a wheelchair or is of short 

stature; or stand several feet away so they do not have to strain their neck to see 
you. 

• Listen carefully; wait for the person to finish their thoughts. 
• If someone appears to be in a crisis, ask them to tell you the best way to help. 
• For large groups, arrange chairs with intermittent spacing to provide opportunity for 

people using wheelchairs to choose where to sit. 
• When assisting someone with low vision: offer your arm (elbow) to guide the person 

and walk slowly; be precise and clear when providing information (e.g. instead of 
“Over there” use “By your left knee”); describe the layout of the room including 
seating arrangements and exits; and inform the person when people are entering 
and exiting the room. It is okay to use words such as ‘look’ and ‘see’. 

• When providing information to someone with hearing loss, keep your voice natural, 
speaking loudly distorts sounds; attract the person’s attention before speaking (it is 
okay to gently touch someone’s shoulder or to wave your hand); face the person as 
they may be lip reading; ask if they prefer other ways of communicating (e.g. 
pen/paper). 

 
Of note: People who are Deaf with a capital ‘D’ are members of the Deaf culture and 
use American Sign Language (ASL).  


